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DigiScope 

(Electronic Stethoscope Version 1.14) 

Specifications: 

• Listening Mode: slow, medium, high 

• Frequency Response: 20 – 20,000 Hz (Low, medium & high frequency filters) 

• Battery: 9v 

• Tube Length: 2 mtr 

• Volume Control: 15 – 90 Db 

• PC interface: RS232 Serial 

 

Features:  

■ Portable and Convenient to Operate  

■ Based on Latest Piezo Sensor Technology  

■ Powerful Electronics Amplify the Sound up to a Maximum of 200 Times  

■ Sound Model: Heart, Lung, And other intra-body sounds.  

■ Frequency Response: 20hz - 20,000hz  

■ Real-Time Record, Edit And Display The Heart Rate  

■ Accommodates infant, pediatric, and adult patients  

■ Integrated with regular stethoscope, ECG waveform display 

 

■ Weight: 490g  

■ Sensitivity: Automatic  



 

*The actual product may not be the same as displayed in the photographs.                                                                                                Page No. 3 

n
am

b
is

o
n

's
 

ELECTRICAL CHARACTERISTICS OF THE CIRCUIT 

 
Operating Supply Voltage : 4 to 12V DC 

Quiescent Current : 4 to 8mA 

Output Power : 500mW to 700mW (Vs = 6V, RL = 8 Ohm, THD = 10%) 

Voltage Gain : 26dB to 46dB 

Bandwidth : 15 Hz to 2000 Hz 

Total Harmonic Distortion : 0.2% (Vs = 6V, RL = 8 Ohm, Pout = 125mW, f = 1 kHz) 

Power Supply Rejection Ratio : 50dB 

 
Frequency Response: 
 

 
 
Distortion Vs Frequency: 
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Distortion Vs Output Power: 
 

 
 
Note 1: Absolute Maximum Ratings indicate limits beyond which damage to the device may 

occur. Operating Ratings indicate conditions for which the device is functional, but do not 

guarantee specific performance limits. Electrical Characteristics state DC and AC electrical 

specifications under particular test conditions which guarantee specific performance limits. This 

assumes that the device is within the Operating Ratings. Specifications are not guaranteed for 

parameters where no limit is given, however, the typical value is a good indication of device 

performance. 

 

Note 2: For operation in ambient temperatures above 25°C, the device must be derated based on 

a 150°C maximum junction temperature and thermal resistance of 107°C/W junction to ambient.  
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Get Set Go:Get Set Go:Get Set Go:Get Set Go: 

1. Make connections 5 

2. Line out connections (Speaker/Computer/iPod/PDA/Headphone) 7 

3. Power supply (The device needs 5.0 Volts) 7 

4. Recommended Hardware  8 

5. Recommended Software 9 

6. Audio Driver/Software settings 11 

7. General Maintenance and Cleaning 11 

8. Service and Warranty 13 

9. Recording Heart Lung sounds using software 14 

1. Make connections: 

First of all make sure that the DigiScopeDigiScopeDigiScopeDigiScope is free of physical damages, if not, please report your 

supplier. Then, connect the power supply as illustrated. Make line out connections. Switch On the 

instrument by pressing down the switch on the front panel & look for Red light at the top panel which 

when glowing indicates the instrument is ready for use.  

 
FRONT VIEW 
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CONNECTIONS & FILTER: 

 

Earphone in 

Stetho line in 
Charger in 

Frequency Filter High/low 

Main Unit 
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Power supply: 

When you see the red light in the front panel is dim or not glowing. Insert the jack of the 9v charger into the Stheto in (on the front panel) & charge it for 
4-6 hours. We recommend you to go through this video for more information:http://youtu.be/pG4IaCHq6e4 

 

LINE OUT CONNECTIONS (for Speaker/Computer/iPod/PDA/Headphone): 

 

 

REPLACE BATTERY (In case the battery is not recharging) 

 

 

 

 
Open the back panel with screw driver,  
Install a 9.0 Volt rechargeable battery. 

9v Rechargeable 

battery. 

BACK VIEW 

Computer out Computer out 
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SPECIFICATIONS HOST PC (HARDWARE) REQUIREMENTS: 

 

• Operating System: MS Windows 98 or higher 

• Processor: Pentium II - 300 MHz or higher 

• RAM: 64 MB minimum 

• HDD: 300 MB for program and disk cache 

• Sound Card with input jack 

 

Performance Specifications: 

• Frequency Response: 20-1000 Hz 

• File Type: .wav, .mp3, .ogg (ogg vorbis), .aup (Audacity project file) format 

 

Third Party Requirements (for IP transmission): Internet, IR or bluetooth enabled computer. 

• Sound Quality: High fidelity sound.  

• Noise: Background noise immunity.  

• Data Transmission: Real-time & Store/Forward IP; all telecom and video conferencing at greater than 9.6Kbps.  

• User Interface: Remote & host units controlled by PC GUI applet.  

• Data Storage: Archiving to a PC in multiple formats.  

• Record Length: limit depends upon your computer system.  

• Playback: at different or normal speed 

OTHER REQUIREMENT: 

SPEAKER HEADPHONE 

1000 Watt Speaker System with WOOFER recommended 

• Speaker WITH Sub Woofer System  
• 1000 Watts : PMPO 
• Magnetically Shielded 
• Control : Volume, Bass & Treble 
• S/N Ratio :>80db 

Accessories: 1 Woofer + 2 Speakers 

Recommended Headphones -  
 

• Closed-Type Headphones with Long Stroke 
Diaphragm 

• Large 40mm Driver Unit with 360kJ/m³ High 
Power Neodymium Magnet for Outstanding Sound 
Quality 
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To bring down the cost of out Digital Stethoscope & to provide various options to the user we do not provide audio equipments. 

However, we recommend the following equipment based on our year long research on sound quality enhancement.  

http://www.gooshing.co.uk/headphones/philips_sbchs900/#prices 
http://www.onino.co.uk/headphones/roland_rh_50.html 
http://www.wikio.co.uk/guide/headphones-earphones-philips-review-5968-5136-page1-sort0.html 
 
 

Specifications Company: SONY 

 
Recommended 

Highly 
Recommended 

Highly 
Recommended 

General  MDR-XD200 MDR-XD400 MDR-XD300 

Sensitivity 102dB/mW 106dB/mW 104dB/mW 

Power Handling Capacity 1.5W 3.0W 1.5W 

Impedance 70ohms 24ohms 70ohms 

Frequency Response 10-22,000Hz 5-30,000Hz 8-25,000Hz 

 
 

 

Software requirement (Recommended): 

 

DigiScopeDigiScopeDigiScopeDigiScope    
 

 

 

For Windows 

http://audacity.sourceforge.net/download/windows 

 

For Mac 

http://www.apple.com/downloads/macosx/audio/audacity.html 

 
AUDACITY powered features: 
Start using 

• Record and Playback sounds. 

• Display and visualize sounds for your ease & diagnosis. 

• Manipulate sounds easily, using your computer system. 

• Save results easily in sound files or group sets of sounds in Project files. 
 
See your Sounds 

• Visualise heart sound, lung sound & other intrabody sound Waveforms. 

• Visualise Spectrograms (frequency spectrum) of heart sounds and lung sounds. 

• Visualise Waveform and Spectrograms together to correlate timing and frequency. 
 
Catch Sounds 

• Record from your DigiScopeDigiScopeDigiScopeDigiScope Digital Stethoscope sounds directly to a Computer system. 



 

*The actual product may not be the same as displayed in the photographs.                                                                                                Page No. 10 

n
am

b
is

o
n

's
 

• Import recordings from your pen drive, iPod, mp3 player or import recordings from email attachments or downloaded 
from the Internet. 

 
Play and Export Sounds 

• Play back sounds on a PC/ Speaker via headphones. 

• Edit and Export sounds to new files for lectures, emails, podcasts, websites, or burn CDs. 
 
Modify Sounds 

• Amplify Sounds. 

• Filter recorded sounds for specific sound characteristics.  

• you can slow down recordings so that details such as splits are more audible. 

• Use files for Electronic Medical Records 

• Label Sound tracks to identify specific events such as S3, S4, murmurs, rhonchi etc. 

• Auscultation Research for Advanced Users 

• Investigate heart sounds and lung sounds for new diagnostic methods. 
 
Award winning Audacity Open Source platform. The software source code is freely available for any researchers or software 
developers who wish to expand the power of auscultation with new analysis software.  

 

After installing Audacity, your system will show Heart sound waveform as below: 
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Software setting for simultaneous listening of Speaker & Headphone: 
Go to your Audio settings > Mixer > Enable multi-streaming playback (as shown in the below 
image.) 
Different drivers/software provides different interface. Please contact your vendor for exact path. 

 

 
 

 
General Maintenance and Cleaning 
 

• Do not immerse the DigiScopeDigiScopeDigiScopeDigiScope in any liquid. If the DigiScopeDigiScopeDigiScopeDigiScope is inadvertently immersed in 

liquid, do NOT Power ON the unit. Completely dry out the inner spaces before trying to use the 

DigiScopeDigiScopeDigiScopeDigiScope again. Contact diagnozit@gmail.com for assistance. 

• Do not sterilize the DigiScopeDigiScopeDigiScopeDigiScope using any sterilization process. 

• Wipe the DigiScopeDigiScopeDigiScopeDigiScope    with alcohol swabs or a soft cloth moistened with alcohol or water. Do not 

use abrasive cleaning agents, and do not allow fluids to enter the device. 

• Avoid extreme heat, cold or humidity for either storage or use of this device.  

• Remove battery if device is not to be used for a period of months. 

• See Tips and Troubleshooting for more information. 
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As electronic equipment DigiScope also needs care. Therefore, handle it with care. If you have 
heavy usage of stethoscope then wear and tear may cause the wire to break from the 
stethoscope. We advise you to secure your chest piece, the way it is shown in the below picture. 
Also make sure to read the user manual carefully before use. 
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Service and Warranty: 
 
For warranty please read the Warranty terms and condition given on the website. 

 

For maintenance, repair, service and contact information, visit the DigiScopeDigiScopeDigiScopeDigiScope  website at 

http://digiscope.diagnozit.com & www.diagnozit.com and check the Support page. Before shipping 

the product for repair, please contact support@diagnozit.com first. 
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Recording Heart Sounds and Lung Sounds 

 
Our Stethoscope provide for the recording and playback of sounds, using the Audio I/O jack. Using your 
stethoscope and an external recorder or playback device, you can: 
 
- Record while listening to a patient. 
- Record voice annotations (dictations) by simply speaking into the stethoscope. 
- Playback recordings, using the stethoscope headphones for high-quality audio. 
 
See safety precautions for Recording. Never record from patients using a recording device that is 
connected to main power, or to any other equipment. Use only battery-powered floating devices. For 
playback with no patient contact, any equipment may be used. 
 
Quick Instructions 
 
Recording and playback can be done very easily with our stethoscope. Simply connect the stethoscope to 
the Line Input of the recording device, listen to the patient, and record.  To listen to the recording, turn off 
the stethoscope, plug the stethoscope into the Headphone Output of the playback device, and listen. 
 
Compatible Devices and Listening to recordings 
 
The following devices may be used for Recording: 
 
- Apple iPod Video with recording attachments. (Other iPods do not provide recording capability) 
- Mp3 players with built-in recording feature. 
- Portable digital recorders. 
- Notebook computer, operating on battery power. 
 
Listening to recordings is best done using the stethoscope in headphone/playback mode. The reason is 
that body sounds, especially heart sounds, contain significant low frequency content. DigiScope 
stethoscope are designed to reproduce these low frequencies accurately. Most heapdhones cannot 
reproduce body sounds adequately. 
 
To listen to recordings, perform the following steps: 
 
1. Turn off your stethoscope, or set the stethoscope volume to 0. 
2. Conect the stethoscope to the Headphone Output of the recording or playback device. 
3. Play back the recordings. 
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Toolbars 
• Control Toolbar (tools, play button, etc.) 
• Thinklabs Toolbar (Importing and editing heart and lung sounds) 
• Mixer Toolbar (volume controls, input device) 
• Meter Toolbar (Input and Output level meters) 
• Edit Toolbar (editing shortcuts) 

 

Control Toolbar 

 

Audio Control Buttons 

 

Skip to Start - moves the cursor to time 0. If you press Play at this point, your project will play from the 
beginning. 

 

Play - starts playing audio at the cursor position. If some audio is selected, only the selection is played. 

 

Loop - if you hold down the Shift key, the Play button changes to a Loop button, which lets you keep playing 
the selection over and over again. 

 

Record - starts recording audio at the project sample rate (the sample rate in the lower-left corner of the 
window). The new track will begin at the current cursor position, so click the "Skip to Start" button first if you 
want the track to begin at time 0. 

 

Pause - temporarily stops playback or recording until you press pause again. 

 

Stop - stops recording or playing. You must do this before making changes, edting, saving or exporting. 

 

Skip to End - moves the cursor to the end of the last track. 
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Thinklabs Toolbar 
 

     

 
The Thinklabs Toolbar provides quick access to special features that are useful for visualizing, 
manipulating and analyzing heart and lung sounds. Some of these functions are also accessible via the 
Thinklabs Menu. 

Thinklabs Special Function Buttons 

 

Import Audio - allows you to import sounds recordings into the current Project/Patient. If you have 
recorded one or more sound(s) from a patient, use Import to open the sound file. Continue to add 
additional files that belong to a given patient, so that the Project contains all the relevant recordings made 
during one exam. Each file is imported into its own separate Track. Note that Stereo recordings will import 
with both Left and Right. Use the Track Menu to Split Tracks, then Delete the unwanted track, and then 
select Mono in the Track Menu. This will convert stereo to Mono and remove a duplicate track. 

 

Amplify - (a Track or part of a Track must be selected to activate this function) - allows you to scale a track 
to be louder and softer. It is recommended that you simply Amplify to the maximum level. This can be 
done automatically by clicking Amplify and then OK, and the Amplify function will adjust to maximize 
without clipping any peaks. If you wish to control the amplification level, enter a value into the dB window. 
Note that a signal doubles in amplitude for every +6dB and halves for every -6dB amplitude change. Note 
that you can select a small segment of a waveform, such as the sounds between peaks, and amplify them 
significantly to enhance murmurs. 

 

Filter  - (a track or part of a track must be selected to activate this function) - allows you to filter a track or 
part of a track. There are various pre-set filters for manipulating heart sounds and lung sounds, or you can 
adjust the Equalizer to filter sound to your own specifications. For instance, you may find that a sharp 
high-pass filter (allow high, block low frequency) enables you to listen to a particular valve sounds very 
clearly. Merely place your cursor over the Equalization Curves, and draw the desired response to create a 
custom filter. 

 

Rate Change - (a track or part of a track must be selected to activate this function) - changes the tempo 
(speed) of the audio without changing the pitch. This will change the length of the selection. This is useful 
for expanding heart sounds so that heart sound splits, S3 or S4 and rapid events such as gallops can be 
slowed down and spread out. 

 

Display Spectrograms On/Off - allows you to view tracks with the Spectrogram below the Waaveform, or 
the Waveform without Spectrogram. The Spectrogram shows frequence content by showing Frequency 
along the vertical axis and color as the Intensity of a given frequency. For instance, if you see a bright 
region towards the lower part of a spectrogram, it suggests that there is a high intensity of low frequency 
energy at that moment in time. This is most useful for seeing murmurs or additional heart sounds such as 
S3 in a waveform which may not be visible on the time-domain plot of the waveform. Note that if you have 
a slow computer or limited memory, it is best to manipulate tracks (zoom, pan, etc.) without the 
Spectrogram, and the click Display to show the Spectrogram once you've zoomed in. Otherwise you may 
find that zooming or panning across a track is very slow. 

 
 

Mixer Toolbar 

 
The Mixer Toolbar has three controls, used to set the volume levels of your audio device and choose the input source. 
The leftmost slider controls the playback volume, the other slider controls the recording volume, and the control on the 
right lets you choose the input source (such as "Microphone", "Line In", "Audio CD", etc.). Use the Record Level 
Meter to set the correct level. To record from your stethoscope, connect the stethoscope to the Mic or Line Input, and 
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select the correct Input source for the stethoscope. Then adjust the Volume Control on the stethoscope, and the Input 
Volume level on the slider. Generally it is best to set the stethoscope Volume Control to Maximum (10). However, 
check the recording for clipping of the signal which will produce distortion and annoying sound artifacts. Ideally, set 
the level to peak at about 50-75% of maximum. Once you have made your recordings, use Amplify on the Thinklabs 
Toolbar to maximize signal levels. 
Changing the Speaker controls has no effect on the audio data in your project - in other words it doesn't matter what 
the output volume level is when you Export or Save a project - the end result is the same. 

 

Edit Toolbar 

 
All of the buttons on this toolbar perform actions - and with a couple of exceptions, they're all just shortcuts of existing 
menu items to save you time.  
Holding the mouse over a tool will show a "tooltip" in case you forget which one is which. 

 
Cut 

 
Copy 

 
Paste 

 
Trim away the audio outside the selection 

 
Silence the selected audio 

 
Undo 

 
Redo (repeat last command). 

 
Zoom In 

 
Zoom Out 

 
Fit selection in window - zooms until the selection just fits inside the window. 

 
Fit project in window - zooms until all of the audio just fits inside the window. 

 

Meter Toolbar 

 
The Meter Toolbar is used for monitoring the input and output audio levels. Typically it is used to make sure that the 
loudest volume is as loud as possible (for maximum fidelity) without clipping or distorting it. The output (playback) 
meter is the green one, on the left in the picture above, and the input (recording) meter is in red, on the right. 

The meters provide a visual indication of the current audio levels going in and out of audacity. 

If you float the Meter Toolbar by dragging it out of the toolbar, you can resize it and even orient it vertically. 
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Normally the meters are only active when you are playing or recording audio. However, you can also monitor input 
when you're not recording - to do this, either select "Monitor Input" from the input meter's pop-up menu, or else just 
click on the input meter. If you have a microphone or other input source attached, you will be able to watch the level of 
the audio before you start recording. 

Each meter shows several characteristics of the audio level at once: 

• The right hand end of the meter corresponds to the point at which the audio will be clipped, and the 
left hand end is silence 

• For stereo, the top bar shows the left channel, and the bottom bar shows the right channel. 
• The brightest part of the bar shows the average audio level (related to the loudness) and the darker 

part of the bar shows the peak audio level. 
• The peak-hold line to the right of this shows the maximum audio level achieved in the last 3 

seconds. 
• Finally, the clipping indicators on the far right of each meter will light up if clipping is detected 

(meaning that the audio was too loud and will sound distorted). 
 

 
 
If clipping is detected when you are recording, you should stop, lower the volume of your input source, and 
start recording again from the start. If the output meter clips then you need to make some or all of your 
tracks quieter using the track gain control.  
If the level of the input (recording) source is too high, you can try to lower the input level using the Mixer 
Toolbar, but if this doesn't work, you should try to lower the volume of the external input source (e.g., your 
microphone, cassette player, or record player). 

  

It is possible, especially if you have an older, slower computer, that the Meter Toolbar may interfere with Audacity's 
ability to record or play audio with the highest quality, because your computer is so busy redrawing the meters that it 
doesn't have time to process enough audio. In this is the case for you, you can disable the Meter Toolbar in the 
Interface tab of the Preferences dialog. 
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Tracks 
• Audio Track 
• Label Track 

Track Layout 

 
 
Tracks show the actual sound waveforms or spectrograms. Getting to know how to work with tracks in 
central to using Thinklabs Phonocardiography for working with heart sounds or lung sounds. The basic 
anatomy of a Track is shown above: 
 
Track Menu - Provides options for manipulating each Track. See Track Pop-Down Menu. Click 
the Playback Select button to select which Track to Play. Playback Select will be bright cyan for the 
selected playback Track. 
 
Waveform Track - Shows the actual heart sound or lung sound time domain waveform. It is possible to 
scroll to any position along the time axis, or zoom in or out to look closely at one section or larger portions 
of a waveform. Note that the color scheme can be changed on the Thinklabs Menu to show a bright blue 
waveform on a dark background (Dark Color Scheme) or a dark waveform on a white background (Light 
Color Scheme). 
 
Label Track - The Label Track provides a place to annotate events along the time axis such as S1, S2, S3, 
murmurs, etc. Label Tracks can be added or deleted as required using Project > Add Label Track to add a 
Label Track, and X to delete the Label Track. Note that if a span of time is selected first, the whole span 
can be labelled. This allows you to select an entire duration of a murmur, for example, and then label it. If 
you then click on the Label, it will immediately highlight the entire span. 
 
Track Name - Every Track can be uniquely named. When Importing a Sound File, it will take the name of 
the file. If you Record a new recording, you must give it a name via the Track Pop-down Menu. 
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Track Control Area - The Track Control Area provides information about the Track(s) and allows for 
control of editing and playback. At the top of the Area are the details of the file you are working with. It is 
either Stereo or Mono. The Sampling Rate is also shown. High Quality audio requires 44100Hz Sampling 
Rate. You can use a lower sampling rate, but if you wish to record CD's, use 44100Hz. Below the 
Stereo/Mono is the data format. 
 
About Stereo or Mono Tracks - Usually, you do not need Stereo for heart sounds or lung sounds 
recorded from the stethosope. If you used an iPod for recording, one channel will probably be blank and 
you only need the Left Channel. If you have Imported a Stereo Track, use the Track Pop-Down Menu to 
first Split Stereo to Mono, and then delete the blank track using the X in the top left corner. 

Controlling and Editing Tracks 
Tracks or parts of tracks can be selected for Playback or Editing as illustrated here: 
 
Playback - You must select which track you would like to hear when the PLAY button is clicked. You do 
this by clicing "Playback Select" (turning it bright Cyan/turquoise) in the Track Control area as shown 
below. 
 
 

 
 
Volume - The Slider just below "Playback Select" controls the Volume of the track playback. There are also 
other places to control volume (a) Mixer Toolbar, and (b) In Windows on the Audio Controls. (If sounds are 
too quiet, consider using the Amplify function on the Thinklabs Toolbar to Amplify a track.) 
 
Editng a Whole Track - An entire track, or part of a track, can be edited (Amplify, Filter, Tempo Change, 
.deleted, copied, etc.). To select the entire track for editing, Click anywhere in the Track Control area, as 
shown below. Notice that the COLOR of the Track Control area is GREY for a track that is selected for 
editing, and the portion of the track itself that will be edited also turns grey. 
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Editing Part of a Track - To select a portion of a Track to edit, DRAG your mouse ACROSS the portion 
you wish to edit. It will turn Grey as shown below. If you wish to select a new portion, simply redo the drag 
operation: 
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Waveform and Spectrum View 

 
 
The Dispay view can show waveform, spectrum, or both. The above image shows both waveform and 
spectrum. It is generally faster to locate sections of interest using waveform only view, and then switching 
to waveform + spectrogram when a region of interest is in view. Turning Spectrogram on of off can be done 
using the Thinklabs Toolbar Display button, or the Toolbar Pulldown Menu.It is also possiblt to show 
Spectrogram only. 

Spectrum View 

 
 
Spectrum Only view is selected on the Track Pop-Down Menu (see below) and shows the Spectrogram 
only. Note that resolution of the Spectrogram can be adjusted via Edit > Preferences > Spectrogram. Using 
a higher resolution requires a faster computer. 
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Track Pop-Down Menu 

 

 

Name... - lets you change the name of the track. Importing a Track will name the Track to the file name. Recording 
will not name a Track - you must name it using this Menu selection. 

Move Track Up - exchange places with the track above this one. 

Move Track Down - exchange places with the track below this one. 

Waveform - sets the display to Waveform - this is the default way of visualizing audio. 

Spectrum - display the track as a spectrogram, showing the amount of energy in different frequency bands. Shoing 
the Spectrum requires a fast computer. It is better to zoom in to the view you want and then show spectrum, rather 
than panning and zooming with Spectrum on. 

Waveform and Spectrum - display both waveform and spectrogram. Can achieve this on ALL tracks at 
once by using the Display button on the Thinklabs Toolbar. See notice above on Spectrum and computer 
speed. 

Split Stereo To Mono - when you Import a Track, if it is a Stereo recording, both Channels/Tracks will show (left and 
right). For phonocardiography use, the second track is redundant or blank. Once you Import a track, Click Split Stereo 
to Mono, and it will split Left and Right. Then DELETE the redundant track (X in the top left corner of the track). 

 

  

Label Track 

 

Label Tracks can be used to annotate an audio Track. They can be used to label S1, S2, S3, S4, murmurs, and even 
save selected portions of a sound. 
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Label Tracks are generated automatically when you Import a sound file. You can then delete the Label Track by 
clicking X in the left corner of the Label Track. 

To create a new Label Track, select New Label Track from the Project Menu. Alternatively, simply click or select 
where you would like to place a label, and choose Add Label at Selection from the Project Menu, and a Label Track 
will be created automatically if one doesn't already exist. 
 
To add a new label, click or select where you want the new label to appear, then select Add Label at Selection from 
the Project Menu, then type the name of the label, and finally press Enter or click outside of the label. 

In addition, you can use the Add Label at Playback Position command from the Project Menu if you want to add a 
label at a certain place while you are listening. By default, this command has a shortcut of Control+M. 

To edit the name of a label, click anywhere in it. Zoom in first if there are too many labels crowded together and you 
are unable to click on the one you want. When a label is selected for editing, it looks like the S2 label below: 

  
When editing the name of a label, you are limited to using just the backspace key for editing. There is currently no 
way to move the insertion point to append a letter to the beginning of a label. 

Once a label is selected, you can move to the next label by pressing Tab, and move to the previous label by pressing 
Shift-Tab. 

To delete a label or multiple labels, select the area containing the label flags you wish to delete, and choose Silence 
from the Edit Menu. Alternatively you can delete an individual label by clicking on it and pressing Backspace until you 
have deleted all of the characters in the label, then pressing Enter. 

To move labels, use the normal editing commands like Cut, Copy, Paste, Delete, and Silence. 

You can save a selection in a label. When you create a new label, the left selection edge determines the position of 
the label's flag. However, the right selection edge is also stored in the label, and when you click on it, the full original 
selection will be restored. If you wish to apply this selection to only a subset of the tracks, shift-click in the label area 
to the left of each track's waveform to change whether each track is part of the selection or not. 

Exporting and Importing label tracks 

Label Tracks are saved when you save an Audacity Project, so if you just want to continue using the labels along with 
the same file, just save a project. But you can also export the labels to a simple text file, and import them. This allows 
you to save information about the locations of events in an audio file for use in another program, and also provides a 
way to mass-edit the labels if necessary. 
To export a Label Track, choose Export Labels... from the File Menu. The exported file will contain one line per label, 
starting with the time offset in seconds, then a tab, and then the name of the label, for example: 

1.217995    Bass intro 

 
3.921073    Guitar enters 
 
7.584454    Drums enter 
 
11.070002   Chorus 

To import a Label Track, choose Import Labels... from the File Menu. 
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Menu Bar 
• Track Pop-Down Menu 

• File Menu 

• Edit Menu 

• View Menu 

• Project Menu 

• Help Menu 

• Thinklabs Menu 

File Menu 

New - creates a new empty window 

Open... - opens an audio file or an Audacity project in a new window (unless the current window is empty). To add 
audio files to an existing project window, use one of the Import commands in the Project menu. 

Close - closes the current window, asking you if you want to save changes. On Windows and Unix, closing the last 
window will quit Audacity, unless you modify this behavior in the Interface Preferences. 

Save Project - saves everything in the window into an Audacity-specific format so that you can save and quickly 
continue your work later. An Audacity project consists of a project file, ending in ".aup", and a project data folder, 
ending in "_data". For example, if you name your project "Composition", then Audacity will create a file called 
"Composition.aup" and a folder called Composition_data. Audacity project files are not meant to be shared with other 
programs - use one of the Export commands (below) when you are finished editing a file. 

Save Project As... - same as Save Project (above), but lets you save a project as a new name. 

Recent Files ... - brings up a list of files you have recently opened in audacity to be re-opened quickly. 

Export As WAV... - exports all of the audio in your project as a WAV file, an industry-standard format for 
uncompressed audio. You can change the standard file format used for exporting from Audacity by opening the File 
Format Preferences . Note that exporting will automatically mix and resample if you have more than one track, or 
varying sample rates. See also File Formats. 

Export Selection As WAV... - same as above, but only exports the current selection. 

Export as MP3... - exports all of the audio as an MP3 file. MP3 files are compressed and therefore take up much less 
disk space, but they lose some audio quality. Another compressed alternative is Ogg Vorbis (below). You can set the 
quality of MP3 compression in the File Format Preferences. See alsoMP3 Exporting. 

Export Selection As MP3... - same as above, but only exports the current selection. 

Export Labels... - if you have a Label Track in your project, this lets you export the labels as a text file. You can 
import labels in the same text format using the "Import Labels..." command in the Project Menu. 

Export Multiple... - lets you split your project into multiple files all in one step. You can either split them vertically (one 
new file per track), or horizontally (using labels in a Label Track to indicate the breaks between exported files. 

Page Setup - configure how Audacity will print out the track waveforms using the Print option, and what printer to use. 

Print - Print out the main window view from audacity showing the tracks and waveforms. 

Exit (Quit) - closes all windows and exits Audacity, prompting you to save any unsaved changes first. 
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Edit Menu 
The Edit Menu provides functions for editing waveforms. In order to activate most functions, you need to select part or 
all of a waveform: 
 

 
 
The dark grey region is selected and any edit command will operate only on that waveform segment. To select a 
region, place your mouse at the strarting point and drag to the end point. To select an entire waveform, Click Ctrl-A. 

Undo - This will undo the last editing operation you performed to your project. Audacity supports full unlimited undo - 
meaning you can undo every editing operation back to when you opened the window. 

Redo - This will redo any editing operations that were just undone. After you perform a new editing operation, you can 
no longer redo the operations that were undone. 

Cut - Removes the selected audio data and places it on the clipboard. Only one "thing" can be on the clipboard at a 
time, but it may contain multiple tracks. 

Copy - Copies the selected audio data to the clipboard without removing it from the project. 

Paste - Inserts whatever is on the clipboard at the position of the selection or cursor in the project, replacing whatever 
audio data is currently selected, if any. 

Trim - Removes everything to the left and right of the selection. 

Delete - Removes the audio data that is currently selected without copying it to the clipboard. 

Silence - Erases the audio data currently selected, replacing it with silence instead of removing it. 

Split - Moves the selected region into its own track or tracks, replacing the affected portion of the original track with 
silence. See the figure below: 

 

Duplicate - Makes a copy of all or part of a track or set of tracks into new tracks. See the figure below: 
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Select ... > All - Selects all of the audio in all of the tracks in the project. 

Select ... > Start to Cursor - Selects from the beginning of the selected tracks to the cursor position. 

Select ... > Cursor to End - Selects from the cursor position to the end of the selected tracks. 

Find Zero Crossings - Modifies the selection slightly so that both the left and right edge of the selection appear on a 
positive-slope zero crossing. This makes it easier to cut and paste audio without resulting in an audible clicking sound. 

Selection Save - Remembers the current selection (or cursor position), allowing you to restore it later. 

Selection Restore - Restores the cursor position to the last position saved by "Selection Save". 

Move Cursor ... > to Track Start - Moves the cursor to the start of the current track. 

Move Cursor ... > to Track End - Move the cursor to the end of the currently selected track. 

Move Cursor ... > to Selection Start - Moves the cursor to the start of the current selection. 

Move Cursor ... > to Selection End - Moves the cursor to the end of the current selection. 

Snap-To ... > Snap On - Enable Snap-To mode. When Snap-To mode is enabled, the selection will be constrained to 
the nearest interval on the time scale, by default the nearest second. So if you click and drag from 4.2 seconds to 9.8 
seconds, it will result in a selection from 4 seconds to 10 seconds, exactly. You can change the units that are snapped 
to using the "Set Selection Format" option in the View Menu . 

Snap-To ... > Snap Off - Turns Snap-To mode off letting you select arbitrary ranges of time 

Preferences... - opens the Preferences dialog. 

  

View Menu 

Zoom In - Zooms in on the horizontal axis of the audio, displaying more detail about less time. You can also use the 
zoom tool to zoom in on a particular part of the window. 

Zoom Normal - Zooms to the default view, which displays about one inch per second. 

Zoom Out - Zooms out, displaying less detail about more time. 

Fit in Window - Zooms out until the entire project just fits in the window. 
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Fit Vertically - Resizes all of the tracks vertically so they all fit inside of the window (if possible). 

Zoom to Selection - Zooms in or out so that the selection fills the window. 

History... - Brings up the history window. It shows all the actions you have performed during the current session, 
including importing. The right-hand column shows the amount of hard disk space your operations used. You can jump 
back and forth between editing steps quite easily by simply clicking on the entries in the window, the same as 
selecting Undo or Redo many times in a row. You can also discard Undo history to save disk space. The history 
window can be kept open while you work. 

Project Menu 

Import Audio... - This command is used to import audio from a standard audio format into your project. Use this 
command if you already have a couple of tracks and you want to add another track to the same project, maybe to mix 
them together. You cannot use this option to import Audacity Projects. The only way to combine two Audacity Projects 
is to open them in separate windows, then copy and paste the tracks. 

Import Labels... - This command takes a text file which contains time codes and labels, and turns them into a Label 
Track. 

Import Raw Data... - This menu command allows you to open a file in virtually any uncompressed format. When you 
select the file, Audacity will analyze it and try to guess its format. It will guess correctly about 90% of the time, so you 
can try just pressing "OK" and listening to the result. If it is not correct, however, you can use the options in the dialog 
to try some other possible encodings. 

At the beginning of your imported track(s), you may notice a little bit of noise. This is probably the file's header, which 
Audacity was not able to parse. Just zoom in and select the noise with the Selection Tool, and then choose Delete 
from the Edit Menu. 

Edit ID3 Tags... - Opens a dialog allowing you to edit the ID3 tags associated with a project, for MP3 exporting 

New Label Track - This creates a new Label Track, which can be very useful for textual annotation. 

Remove Tracks - This command removes the selected track or tracks from the project. Even if only part of a track is 
selected, the entire track is removed. You can also delete a track by clicking the X in its upper-left corner. To cut out 
only part of the audio in a track, use Delete or Silence. 

Add Label at Selection - This menu item lets you create a new label at the current selection. You can title the label 
by typing with the keyboard and then hitting "Enter" when you're done. 

Add Label at Playback Position - This menu item lets you create a new label at the current location where you are 
playing or recording. Do this if you want to mark a certain passage while you're listening to it. You can title the label by 
typing with the keyboard and then hitting "Enter" or "Return" when you're done. Only available whilst audacity is 
playing. 

 

Help Menu 

Thinklabs Phonocardiography Help - Takes you to www.thinklabsmedical.com Help information on using Thinklabs 
Phonocardiography Software.. 

Audacity Help - The original Audacity Help information. This can be useful to see some of the tools that exist in 
standard Audacity. In some cases, the standard Audacity provides features that have been removed from Thinklabs 
Phonocardiography. 
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About Thinklabs - takes you to www.thinklabsmedical.com. 

About Audacity - displays the version number and credits. If you compiled Audacity yourself, check here to verify 
which optional modules were successfully compiled in. 

 

  

Thinklabs Menu 

The items in this menu only work when you have audio selected. Audacity does not have any real-time effects; you 
must select the audio, apply the effect, and then listen to the results. 
Most effects have a Preview button. Clicking on this button plays up to three seconds of audio, allowing you to hear 
what it will sound like after the effect is applied. This is useful for fine-tuning the effect parameters. 

Amplify - changes the volume of the selected audio. If you click the "Allow clipping" checkbox, it will let you amplify so 
much that the audio ends up beyond the range of the waveform, and is clipped (distorted). The default value when 
you open the effect is to amplifiy so that the loudest part of the selection is as loud as possible without distortion. 

Change Tempo - changes the tempo (speed) of the audio without changing the pitch. This will change the length of 
the selection. This is useful for expanding sounds so that heart sound splits and other rapid events can be slowed 
down. Note that you must select part or whole track to activate this function. 

Equalization - Boost or reduce arbitrary frequencies. You can select one of a number of different curves designed to 
equalize the sound of some popular record manufacturers, or draw your own curve. 

FFT Filter - similar to Equalization, lets you enhance or reduce arbitrary frequencies. The curve here uses a linear 
scale for frequency. 

Normalize - allows you to correct for DC offset (a vertical displacement of the track) and/or amplify such that the 
maximum amplitude is a fixed amount, -3 dB. It's useful to normalize all of your tracks before mixing. If you have a lot 
of tracks, you may then need to use the track gain sliders to turn some down. 

High Pass Filter - allows you to filter out lower frequencies and keep the higher frequencies. This is useful for filtering 
out heart sounds when you are only interested in lung sounds, enhancing valve clicks, etc. This is a quick filter to use, 
however we recommend using the Filter Button on the Thinklabs Toolbar for better control of the filtering parameters. 

Low Pass Filter - allows you to filter out higher frequencies and keep the lower frequencies. This is useful for filtering 
out hiss or white noise, ambient noise, or breath sounds, and enhance heart sounds. This is a quick filter to use, 
however we recommend using Filter Button on the Audacity Toolbar for better control of the filtering parameters. 

Plot Spectrum - To use this feature, first select a region of audio from a single track, then select "Plot Spectrum". It 
opens up a window that displays the Power Spectrum of the audio over that region, calculated using the Fast Fourier 
Transform. The graph represents how much energy is in each frequency. As you move the mouse over the display, it 
shows you the nearest peak frequency. This window can also display other common functions that are calculated 
using the Fast Fourier Transform, including three versions of the Autocorrelation function. The Enhanced 
Autocorrelation function is very good at identifying the pitch of a note. 

Import Audio - allows you to add a sound file to the Project (Patient). If you have recorded one or more heart or lung 
sounds, and you wish to work on them, or add them to other sound tracks you already have open, use Import to 
import the sound file into a new audio track. When you use Import, a Label Track will also be added to facilitate 
annotation of the imported sound.. 

New Label Track - allows you to add a new Label Track to a project. This is to provide annotation.. 
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Light/Dark Color Scheme - There are two color schemes - dark background and light waveforms (Dark Color 
Scheme), or light background and dark waveforms (Light Color Schemes). The Dark Color Scheme is intended for 
viewing on a computer screen, and the Light Color Scheme is useful for copying the screen to paste into reports that 
might be printed. By using a Light Color Scheme for printed reports, you save toner ink, and create prints that are 
easier to read. You may also find the Light Color Scheme to be more effective during Powerpoint presentations or 
other teaching using a projector. 

How to Copy the Display - quick instructions on copying the display to the clip-board so that you can paste the 
screen image into a document or report. 
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Other 
• Preferences 
• Sound File Formats 
• Envelope Editing 
• MP3 Exporting 
• General Public License 

Preferences 

Audio I/O 

• Playback Device - Use this control to select the device that will be used for playback / audio 
output. This is usually only applicable if your computer has more than one sound card. 

• Recording Device - Select the devce that will be used for recording / audio input. Note that many 
devices have multiplesources such as Microphone and Line in - to select the input source you will need to 
use the Mixer Toolbar. 
For finer control over audio I/O, open your system's Sound control panel or the control panel software that 
came with your sound card. 

• Recording Channels - Use this to select the number of channels to record simultaneously. Select 
1 for mono and 2 for stereo. Audacity will support recording more simultaneous channels, but note that 
most sound cards only support stereo, and even if your sound card supports more than 2 inputs, you need 
a fast computer and a large, fast hard disk to record many channels for a long time. 
Mono recording is not the same on all computers or sound cards. Sometimes recording mono only records 
the left channel, and sometimes it mixes the left and right channels. 

• Play other tracks while recording new one - When this box is checked, Audacity will play 
existing tracks when you press record - otherwise it simply records the new track without letting you hear 
what you've already recorded. You can use this option to record harmonies with yourself or add a 
voiceover. 
You may notice that when you play the two tracks you recorded together, they aren't synchronized. This is 
unavoidable to a certain extent, although Audacity tries to minimize it. To fix it, you will need to grab 
the Time Shift tool and slide one of the tracks around until it sounds right. 

• Hardware Playthrough (Mac Only) - plays the audio you are recording straight back out to your 
headphones or speakers so you can hear it. This option is done in harware, so it is fast and doesn't 
consume resources. However, it is only possibly if input and output are on the same sound device.  
PC users can do the same thing in their volume control settings, turning up the relevant audio input. 

• Software Playthrough - Does the same thing as hardware playthrough, but in software. This 
means that the audio you hear may be slightly delayed relative to the input, and activating this option will 
use some more system resources. However, it works on all systems, even if you are recording from one 
device and playing back through another. 
 

Quality 

• Default Sample Rate - This controls the sample rate of new projects. To change the sample rate of 
an existing project, use the control in the lower-left corner of the main project window. 

• Default Sample Format - This controls the default format used to store audio samples. 16-bit takes 
up the least space and is equivalent to audio CD quality. 32-bit float takes up twice as much space but is 
much more flexible. 
If you have a fast computer and enough disk space, you should always use 32-bit float samples while 
editing, and then export your final mix as a 16-bit WAV file (the default). 
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• Real-time sample rate converter - Audacity has more than one sample rate converter that's used 
when you have a track that's not the same sample rate as the project. This option lets you set the 
converter used during real-time playback, which can be different than the one you use during Export or 
mixing. 

• High-quality sample rate converter - Audacity has more than one sample rate converter that's 
used when you have a track that's not the same sample rate as the project. This option lets you set the 
converter used during Export and mixing, which can be different than the one you use for real-time 
playback. 

• Real-time dither - Dithering is used when converting high-quality samples with a lot of dynamic 
range, to CD-quality samples, with less dynamic range. A small amount of dithering can make the audio 
sound a little bit better, but it can also slow down processing a little bit. This option lets you set the 
dithering used for real-time playback. 

• High-quality dither - Dithering is used when converting high-quality samples with a lot of dynamic 
range, to CD-quality samples, with less dynamic range. A small amount of dithering can make the audio 
sound a little bit better, but it can also slow down processing a little bit. This option lets you set the 
dithering used during Export and mixing. 
 

File Formats 

• When importing uncompressed audio files into Audacity 
o Make a copy of the file before editing (safer) - Selecting this means that Audacity will 

take longer to import files, but it will always have its own copy of any audio you are using in a project. You 
can move, change, or throw away your files immediately after you open or import them into Audacity. 

o Read directly from the original file (faster) - Selecting this means that Audacity depends 
on your original audio files being there, and only stores changes you make to these files. If you move, 
change, or throw away one of the files you imported into Audacity, your project may become unusable. 
However, because Audacity doesn't need to make copies of everything first, it can import files in much 
less time. 

o Uncompressed Export Format - This lets you select the format that Audacity will use 
when you export uncompressed files. 11 common options are displayed in the list, but you can also select 
"Other" and choose a nonstandard file format for Audacity to export. 

o Ogg Export Setup - Use this control to set the quality of Ogg Vorbis exporting. Ogg Vorbis 
is a compressed audio format similar to MP3, but free of patents and licensing fees. A normal quality Ogg 
Vorbis file is encoded with a quality setting of "5". Note that unlike MP3 encoding, Ogg Vorbis does not let 
you set a bitrate, because some audio clips are easier to compress than others. Increasing the quality will 
always increase the file size, however. 

o  Export Setup - Use these controls to locate your MP3 encoder and set the quality of MP3 
encoding. Higher quality files take up more space, so you will need to find the level of quality you feel is 
the best compromise. For more information, see Exporting MP3 Files.Spectrograms 
 

You can view any audio track as a Spectrogram instead of a Waveform by selecting one of the Spectral 
views from the Track Pop-Down Menu. This dialog lets you adjust some of the settings for these 
spectrograms. 

o FFT Size - The size of the Fast Fourier Transform (FFT) affects how much vertical 
(frequency) detail you see. Larger FFT sizes give you more bass resolution and less temporal (timing) 
resolution, and they are slower. 

o Grayscale - Select this for gray spectrograms instead of colored ones. 
o Maximum Frequency - Set this value anywhere from a couple of hundred hertz to half the 

sample rate (i.e. 22050 Hz if the sample rate is 44100 Hz). For some applications, such as speech 
recognition or pitch extraction, very high frequencies are not important (visually), so this allows you to hide 



 

*The actual product may not be the same as displayed in the photographs.                                                                                                Page No. 33 

n
am

b
is

o
n

's
 

these and only focus on the ones you care about. 
 

Directories 

Use this panel to set the location of Audacity's temporary directory (folder). Audacity uses this directory 
whenever you work on a project that you haven't saved as an Audacity Project (AUP file) yet. You have to 
restart Audacity (close and open it again) for changes to the temporary directory to take effect. 

Interface 

o Autoscroll while playing - Scrolls the window for you while playing, so that the playback 
cursor is always in the window. This can hurt playback performance on slower computers. 

o Always allow pausing - Normally the Pause button is only enabled while you are playing 
or recording. Checking this box allows you to set the pause button anytime, which allows you to press 
Record and not have the recording start until you unpause it. Sometimes starting a paused recording can 
be faster than starting to record in the first place. 

o Update spectrogram while playing - Because spectrograms are slower to draw, normally 
they are not drawn during playback, but this option lets you draw the spectrograms anyway. 

o Enable Edit Toolbar - Sets whether or not you want to display the Edit Toolbar, which has 
some common shortcuts for editing commands. 

o Enable Mixer Toolbar - Sets whether or not you want to display the Mixer Toolbar, which 
lets you set the volume levels and input source. 

o Enable Meter Toolbar - Sets whether or not you want to display the Meter Toolbar for 
setting audio recording and playback levels. 

o Quit Audacity upon closing last window - By default on Windows and X-Windows (but 
not Mac OS), Audacity quits when you close the last project window. If you uncheck this box, Audacity will 
open a new blank document instead of quitting. To quit Audacity in this case, you must specifically select 
Exit (or Quit) from the File menu. 

o Enable dragging of left and right selection edges - Normally, when you move the mouse 
over the left and right edge of a selection, the cursor changes to a left or right pointer, and you can adjust 
that edge of the selection independently. If you don't like this feature, uncheck this box, and then clicking 
will always create a new selection (unless you hold down Shift to extend an existing selection). 

o Language - sets the language used by Audacity. Language files are named "audacity.mo" 
and are found in the "Languages" folder on Windows and Mac OS X, or in /usr/share/locale or 
/usr/local/share/locale on most Unix systems. Audacity will detect new languages the next time you start 
it. 
 

Keyboard 

This panel lets you change keyboard shortcuts. All of the commands that appear in Audacity menus 
appear on the left, along with a few other buttons that can get keyboard shortcuts. To change a command, 
first click on the command you want to change. Then type the new keyboard shortcut on your keyboard. 
Verify that the correct shortcut appears in the box below. If it's what you want, press the Set button. Or to 
get rid of a keyboard shortcut, press Clear.  
To reset to Audacity's defaults, press the Defaults button. This will get rid of any changes you have 
made.  
If you have customized your keyboard layout and want to share it with someone else, you can 
press Save... and save your complete keyboard layout as an XML file that you can share. To load an 
existing layout, press the Load... button and locate the XML file. 
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Mouse 

This panel doesn't let you change anything, but it lets you view all of the commands and actions that you 
can do using the mouse, many by holding down extra modifier keys. 

• Sound File Formats 

Audacity Project format (AUP) 

Audacity projects are stored in an AUP file, which is a format that has been highly optimized for Audacity 
so that it can open and save projects quickly. In order to achieve this speed, Audacity breaks larger audio 
files into several smaller pieces and stores these pieces in a directory with a similar name as the project. 
For example, if you name a project "chanson", then Audacity will create a project file called chanson.aup to 
store the general information about your project, and it will store your audio in several files inside a 
directory called chanson_data. While the Audacity Project format is based on XML and is meant to be 
open, it is not currently compatible with any other audio programs, so when you are finished working on a 
project and you want to be able to edit the audio in another program, select Export from the File Menu. 

WAV (Windows Wave format) 

This is the default uncompressed audio format on Windows, and is supported on almost all computer 
systems. Audacity can read and write this format. People working with multichannel audio at very high 
quality settings, or with very long recordings, should note that the maximum size of a wav file is 2GB. 

AIFF (Audio Interchange File Format) 

This is the default uncompressed audio format on the Macintosh, and it is supported by most computer 
systems, but it is not quite as common as the WAV format. Audacity can read and write this format. 

Sun Au / NeXT 

This is the default audio format on Sun and NeXT computers, and usually u-law compressed, so it is not a 
very high quality format. U-law compression is a very simple, fast but low quality way to reduce the size of 
the audio by about 50%. This format was one of the first audio formats supported by Web browsers, and it 
is still often used for short sound effects where quality is not as important. 
Audacity exports both 8-bit u-law files, and 16-bit uncompressed files, which are the same quality as wav 
or aiff files. 

MP3 (MPEG I, Layer 3) 

This is a compressed audio format that is a very popular way to store music. It can compress audio by a 
factor of 10:1 with very little degradation in quality. Audacity can both import and export this format. For 
more information on how to export MP3 files from within Audacity, see Exporting MP3 Files. 

Ogg Vorbis 

This compressed audio format was designed to be a free alternative to MP3. Ogg Vorbis files are not as 
common, but they are about the same size as MP3 with better quality to rival AAC or WMA. Audacity can 
import and export this format. 
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• MP3 Exporting 

Audacity cannot encode MP3 files by itself, because the MP3 encoding algorithm is patented and cannot 
legally be used in free programs. However, Audacity has been programmed to recognize other existing 
MP3 encoders that you can download separately. All you have to do is obtain the appropriate MP3 
encoder for your computer and then show Audacity where it is located. 

If you 
use... 

You need to... 

Windows Download LAME and look for the file called lame_enc.dll 

Linux/Unix 
Download LAME and compile it as a shared object, then look for the file 
called libmp3lame.so 

Macintosh Download LAMELib (see our website for more info). 

For links to these MP3 encoders, go to the Audacity web page (http://audacity.sourceforge.net/) and go to 
the page for your operating system. 
 
The first time you try to export an MP3 file, Audacity will ask you to locate your MP3 encoder. Locate the 
file indicated above. From then on, Audacity will not need to ask you again and you will be able to export 
MP3 files easily. 

 

General Public License 

Note: Audacity is distributed under the terms of the GNU General Public License (GPL) - the full text of the 
license is below. All of the source code to Audacity is available from http://audacity.sourceforge.net. 
However, some of the libraries that Audacity is based on are distributed under the terms of different (but 
GPL-compatible) licenses. 

Version 2, June 1991 

59 Temple Place - Suite 330, Boston, MA 02111-1307, USA 
Everyone is permitted to copy and distribute verbatim copies 

of this license document, but changing it is not allowed. 

Preamble 

The licenses for most software are designed to take away your freedom to share and change it. By 
contrast, the GNU General Public License is intended to guarantee your freedom to share and change free 
software--to make sure the software is free for all its users. This General Public License applies to most of 
the Free Software Foundation's software and to any other program whose authors commit to using it. 
(Some other Free Software Foundation software is covered by the GNU Library General Public License 
instead.) You can apply it to your programs, too. 

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are 
designed to make sure that you have the freedom to distribute copies of free software (and charge for this 
service if you wish), that you receive source code or can get it if you want it, that you can change the 
software or use pieces of it in new free programs; and that you know you can do these things. 
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To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask 
you to surrender the rights. These restrictions translate to certain responsibilities for you if you distribute 
copies of the software, or if you modify it. 

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the 
recipients all the rights that you have. You must make sure that they, too, receive or can get the source 
code. And you must show them these terms so they know their rights. 

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which gives 
you legal permission to copy, distribute and/or modify the software. 

Also, for each author's protection and ours, we want to make certain that everyone understands that there 
is no warranty for this free software. If the software is modified by someone else and passed on, we want 
its recipients to know that what they have is not the original, so that any problems introduced by others will 
not reflect on the original authors' reputations. 

Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that 
redistributors of a free program will individually obtain patent licenses, in effect making the program 
proprietary. To prevent this, we have made it clear that any patent must be licensed for everyone's free 
use or not licensed at all. 

The precise terms and conditions for copying, distribution and modification follow. 

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND 
MODIFICATION 

0. This License applies to any program or other work which contains a notice placed by the copyright 
holder saying it may be distributed under the terms of this General Public License. The "Program", below, 
refers to any such program or work, and a "work based on the Program" means either the Program or any 
derivative work under copyright law: that is to say, a work containing the Program or a portion of it, either 
verbatim or with modifications and/or translated into another language. (Hereinafter, translation is included 
without limitation in the term "modification".) Each licensee is addressed as "you". 

Activities other than copying, distribution and modification are not covered by this License; they are 
outside its scope. The act of running the Program is not restricted, and the output from the Program is 
covered only if its contents constitute a work based on the Program (independent of having been made by 
running the Program). Whether that is true depends on what the Program does. 

1. You may copy and distribute verbatim copies of the Program's source code as you receive it, in any 
medium, provided that you conspicuously and appropriately publish on each copy an appropriate copyright 
notice and disclaimer of warranty; keep intact all the notices that refer to this License and to the absence 
of any warranty; and give any other recipients of the Program a copy of this License along with the 
Program. 

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty 
protection in exchange for a fee. 

2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based on 
the Program, and copy and distribute such modifications or work under the terms of Section 1 above, 
provided that you also meet all of these conditions: 

o a) You must cause the modified files to carry prominent notices stating that you changed 
the files and the date of any change. 
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o b) You must cause any work that you distribute or publish, that in whole or in part contains 
or is derived from the Program or any part thereof, to be licensed as a whole at no charge to all third 
parties under the terms of this License. 

o c) If the modified program normally reads commands interactively when run, you must 
cause it, when started running for such interactive use in the most ordinary way, to print or display an 
announcement including an appropriate copyright notice and a notice that there is no warranty (or else, 
saying that you provide a warranty) and that users may redistribute the program under these conditions, 
and telling the user how to view a copy of this License. (Exception: if the Program itself is interactive but 
does not normally print such an announcement, your work based on the Program is not required to print 
an announcement.) 

These requirements apply to the modified work as a whole. If identifiable sections of that work are not 
derived from the Program, and can be reasonably considered independent and separate works in 
themselves, then this License, and its terms, do not apply to those sections when you distribute them as 
separate works. But when you distribute the same sections as part of a whole which is a work based on 
the Program, the distribution of the whole must be on the terms of this License, whose permissions for 
other licensees extend to the entire whole, and thus to each and every part regardless of who wrote it. 

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; 
rather, the intent is to exercise the right to control the distribution of derivative or collective works based on 
the Program. 

In addition, mere aggregation of another work not based on the Program with the Program (or with a work 
based on the Program) on a volume of a storage or distribution medium does not bring the other work 
under the scope of this License. 

3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or 
executable form under the terms of Sections 1 and 2 above provided that you also do one of the following: 

o a) Accompany it with the complete corresponding machine-readable source code, which 
must be distributed under the terms of Sections 1 and 2 above on a medium customarily used for 
software interchange; or, 

o b) Accompany it with a written offer, valid for at least three years, to give any third party, for 
a charge no more than your cost of physically performing source distribution, a complete machine-
readable copy of the corresponding source code, to be distributed under the terms of Sections 1 and 2 
above on a medium customarily used for software interchange; or, 

o c) Accompany it with the information you received as to the offer to distribute corresponding 
source code. (This alternative is allowed only for noncommercial distribution and only if you received the 
program in object code or executable form with such an offer, in accord with Subsection b above.) 

The source code for a work means the preferred form of the work for making modifications to it. For an 
executable work, complete source code means all the source code for all modules it contains, plus any 
associated interface definition files, plus the scripts used to control compilation and installation of the 
executable. However, as a special exception, the source code distributed need not include anything that is 
normally distributed (in either source or binary form) with the major components (compiler, kernel, and so 
on) of the operating system on which the executable runs, unless that component itself accompanies the 
executable. 

If distribution of executable or object code is made by offering access to copy from a designated place, 
then offering equivalent access to copy the source code from the same place counts as distribution of the 
source code, even though third parties are not compelled to copy the source along with the object code. 

4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided under 
this License. Any attempt otherwise to copy, modify, sublicense or distribute the Program is void, and will 
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automatically terminate your rights under this License. However, parties who have received copies, or 
rights, from you under this License will not have their licenses terminated so long as such parties remain in 
full compliance. 

5. You are not required to accept this License, since you have not signed it. However, nothing else grants 
you permission to modify or distribute the Program or its derivative works. These actions are prohibited by 
law if you do not accept this License. Therefore, by modifying or distributing the Program (or any work 
based on the Program), you indicate your acceptance of this License to do so, and all its terms and 
conditions for copying, distributing or modifying the Program or works based on it. 

6. Each time you redistribute the Program (or any work based on the Program), the recipient automatically 
receives a license from the original licensor to copy, distribute or modify the Program subject to these 
terms and conditions. You may not impose any further restrictions on the recipients' exercise of the rights 
granted herein. You are not responsible for enforcing compliance by third parties to this License. 

7. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason 
(not limited to patent issues), conditions are imposed on you (whether by court order, agreement or 
otherwise) that contradict the conditions of this License, they do not excuse you from the conditions of this 
License. If you cannot distribute so as to satisfy simultaneously your obligations under this License and 
any other pertinent obligations, then as a consequence you may not distribute the Program at all. For 
example, if a patent license would not permit royalty-free redistribution of the Program by all those who 
receive copies directly or indirectly through you, then the only way you could satisfy both it and this 
License would be to refrain entirely from distribution of the Program. 

If any portion of this section is held invalid or unenforceable under any particular circumstance, the 
balance of the section is intended to apply and the section as a whole is intended to apply in other 
circumstances. 

It is not the purpose of this section to induce you to infringe any patents or other property right claims or to 
contest validity of any such claims; this section has the sole purpose of protecting the integrity of the free 
software distribution system, which is implemented by public license practices. Many people have made 
generous contributions to the wide range of software distributed through that system in reliance on 
consistent application of that system; it is up to the author/donor to decide if he or she is willing to 
distribute software through any other system and a licensee cannot impose that choice. 

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this 
License. 

8. If the distribution and/or use of the Program is restricted in certain countries either by patents or by 
copyrighted interfaces, the original copyright holder who places the Program under this License may add 
an explicit geographical distribution limitation excluding those countries, so that distribution is permitted 
only in or among countries not thus excluded. In such case, this License incorporates the limitation as if 
written in the body of this License. 

9. The Free Software Foundation may publish revised and/or new versions of the General Public License 
from time to time. Such new versions will be similar in spirit to the present version, but may differ in detail 
to address new problems or concerns. 

Each version is given a distinguishing version number. If the Program specifies a version number of this 
License which applies to it and "any later version", you have the option of following the terms and 
conditions either of that version or of any later version published by the Free Software Foundation. If the 
Program does not specify a version number of this License, you may choose any version ever published 
by the Free Software Foundation. 
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10. If you wish to incorporate parts of the Program into other free programs whose distribution conditions 
are different, write to the author to ask for permission. For software which is copyrighted by the Free 
Software Foundation, write to the Free Software Foundation; we sometimes make exceptions for this. Our 
decision will be guided by the two goals of preserving the free status of all derivatives of our free software 
and of promoting the sharing and reuse of software generally. 

NO WARRANTY 

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR 
THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE 
STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE 
PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND 
PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, 
YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION. 

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY 
COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE 
PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY 
GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR 
INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA 
BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A 
FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH 
HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 

 
 


